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The MadCap Software plug-in API lets you integrate Flare with DLLs that you produce. For example,
you might want to add customized ribbons, menus, or toolbar buttons to Flare.

Most of the information provided regarding the plug-in APl is intended for developers or those who
are quite familiar with APIs and DLLs.

WHAT YOU NEED

Here is what you need before you begin:
m Latest build of MadCap Flare
s B3.PluginAPIKit.dll

m Visual Studio 2010 or later
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HOW TO CREATE A PLUG-IN

1. InVisual Studio, create a new Class Library project.

> N

In the new project dialog, select .Net Framework 4.0.
Add a library reference to the B3.PluginAPIKit.dll assembly.

Implement the IPlugin interface. See "IPlugin Interface" on page 12.

% EXAMPLE

Following is a basic example where the function of the plugin is to simply show a
message box whenever the plugin is activated or deactivated.

using System;
using System.Windows.Forms;
using B3.PluginAPIKit;
namespace DemoPlugin
{
public class DemoPlugin:IPlugin
{
private IHost mHost;
private bool mActivated;
public bool IsActivated
{
get { return mActivated; }
}
public string GetVersion ()
{
return "1.0";
}
public string GetAuthor ()
{
return "Bob Smith";
}
public string GetDescription ()
{

return "Displays a message box.";
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public string GetName ()
{
return "DemoPlugin";
}
public void Initialize (IHost host)
{
mHost = host;
}
public void Execute ()
{
mActivated = true;
MessageBox.Show (GetName () + " activated!");
}
public void Stop/()
{
MessageBox.Show (GetName () + " deactivated!");
mHost.Dispose () ;
mActivated = false;
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HOW TO INTEGRATE A PLUG-IN INTO FLARE

Flare monitors the Plugins folder under its root application directory. Any valid plug-in detected
inside the Plugins folder will be listed on the Plugins tab of the Options dialog in Flare.

1. Make sure Flare is not open.

2. In Windows navigate to the Flare.app\Plugins folder where you have installed Flare (e.g.,
C:\Program Files\MadCap Software\MadCap Flare15\Flare.app\Plugins).

y |OS(C:] » Program Files » MadCap Software » MadCap Flare 14 » Flare.app |

Marme a Date modified Type Size
) Plugins 6,/18/2018 9:33 AM  File folder

Resources 6/18/2018 %:34 AM  File folder

Aspose,Cells.dll B/13/2018 1207 AM  Application extens.., 0,398 KB

Aspose.Pdf.dll 6/13/2018 1207 AM  Application extens... 20,131 KB

D Aspose.Total.lic 6/13/201812:07 AM  License 1KB

Aspose,Words.dll B/13/2018 1207 AM  Application extens.., 0,143 KB

AxInterop. WMPLib.dll 6/13/2018 1207 AM  Application extens... &0 KB

B3.ActivationCommonKit.dll £/13/2018 3:16 PM Application extens... 46 KB

B3 ActiveDirectorykit.dll £,/13/2018 3:16 PM Application extens... &0 KB

rﬁ e P P SN = B0 .98 Ok Bmelimatiom cocben e 21 D

3. Within the Plugins directory, create a new folder named after your plugin. For the example
above, the plugin directory is named “DemoPlugin.”

4. Add your built plug-in assemblies and resource files into that directory. The directory hier-
archy should look as follows:

Flare.App

bPIugins
hDemoPIugin

b Plugin Assemblies + Resource Files
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HOW TO ENABLE THE PLUG-IN WITHIN FLARE

1. Launch Flare.

2. Select File > Options. The Options dialog opens.
3. Select the Plugins tab. You should see a row that represents your DLL.
4. Click Enable.
e
General Mame Description Version
Interface Windoze Tests ribbons, menus, toolstrip APT 1.1
Source Control 1
XML Editar

Project Analysis
Auto Suggestion
Spelling

Index & Concepts
Keyboard Shortats
Build

Review

Plugins

Services

NOTE: You can also use the Plugins tab in the Options dialog (File > Options) to dis-

able a plugin.

5. Restart Flare.
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INTERFACES AND ENUMERATIONS

For more details on the interfaces and enumerations with the plug-in API, see the following:
m "IPlugin Interface" on page 12
m 'IHost Interface" on page 13
« "IEditorContext Interface" on page 14
o "IDocument Interface" on page 15
o "ISelection Interface" on page 18
o "EditorView Enumeration” on page 19
« 'INavContext Interface" on page 20

o "lCustomToolBar Interface" on page 21

o

"IToolStripMenultem Interface" on page 22

o

"IRibbon Interface" on page 23

(e)

"IRibbonControlData Interface" on page 24

o

'IRibbonMenuData Interface" on page 25

[¢]

"IRibbonTab Interface" on page 25

o

"IRibbonGroup Interface" on page 26

o

"IRibbonComboBox Interface" on page 28

e}

"IRibbonMenu Interface" on page 29

o

"RibbonlconSize Enumeration” on page 30

EXAMPLES

For examples of creating and working with the plug-in API, see the following:

‘Context Menu Example” on page 32

"Controlled Language Example" on page 33

"Ribbon Example" on page 37

"Search and Change Text Style Example" on page 40

"Toolbar Example" on page 41
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BEST PRACTICES/GUIDELINES

Following are some best practices an guidelines to keep in mind as you work with the plug-in API.

TARGET FRAMEWORK

m Currently, the Flare APl framework only supports libraries targeted to .NET Framework 4.0.

INITIALIZATION

m [Plugin.Initialize(IHost) should only be used to set the instance of IHost passed in to a class
variable.

m Callsto obtain the editor or navigation context should be done in IPlugin.Execute().

CLEANING UP

m Events should be properly detached.

m Changes made to the Ul should be reverted back to its original state (e.g., ribbon, context
menus, tool strip).

m |Host.Dispose() should be called in IPlugin.Stop(). This will dispose of most of the menu bar
items and ribbon items added.

m The IPlugin.IsActivated property should be set to false.

REFERENCES

m The working directory is the base application directory. If you are passing in a URL to any of
the interface methods, relative paths are relative to the “Plugins” directory. For example,
‘DemoPlugin/Icons/Filter.png” maps to:

C:/<Flare Install Path>/Flare.app/Plugins/DemoPlugin/lcons/Filter.png.
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CHAPTER 2

Interfaces and Enumerations

There are several interfaces and enumerations involved with the plug-in API.

This chapter discusses the following:

IPlugin Interface ... .. 12

IHOSt INterface . 13
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IPlugin Interface

The IPlugin interface represents the plug-in. For the plug-in assembly to be considered valid, it must
implement the IPlugin interface.

PROPERTIES

m bool IsActivated Gets a value indicating whether the plug-in is activated or not.

METHODS

m void Execute() Activates the plug-in. This method is called when users click Enable on the Plu-
gins tab of the Options dialog (File > Options).

m string GetAuthor() Returns the author of the plug-in.

m string GetDescription() Returns the description of the plug-in.
m string GetName() Returns the name of the plug-in.

m string GetVersion() Returns the version of the plug-in.

= void Initialize(IHost) Initializes the plug-in. An instance of IHost is passed in as a parameter,
which gives users access to Flare components. See "IHost Interface” on the next page.

m void Stop() Deactivates the plug-in. This method is called when users click Disable on the Plu-
gins tab of the Options dialog (File > Options).
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IHost Interface

The IHost interface represents the host application. An instance of IHost is be passed in as a para-
meter to the Initialize() method in the IPlugin interface. See "IPlugin Interface" on the previous page.

METHODS

m string GetCompany() Returns the name of the company.

m |EditorContext GetEditorContext() Returns the active IEditorContext object. See "IEd-
itorContext Interface" on the next page.

m string GetName() Returns the name of the active application.

m /NavContext GetNavContext() Returns the active INavContext object. See "INavContext Inter-
face" on page 20.

m void Dispose() Cleans up the instance of IHost after usage. This must be called whenever the
plug-in is disabled.
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|EditorContext Interface

Aninstance of IEditorContext is returned using the GetEditorContext() method in the IHost interface
(see "IHost Interface" on the previous page). IEditorContext gives access to opened Flare doc-
uments in the editor.

EVENTS

m DocumentSwitched Occurs when the active document changes.

METHODS
m /Document GetActiveDocument() Returns the currently active IDocument. See "IDocument
Interface" on the next page.

m /Enumerable</Document> GetDocuments() Returns a System.Collections.|Enumerable con-
taining all the IDocument(s) currently open. See "IDocument Interface" on the next page.

m XmISchema GetMadCapSchema() Returns the System.Xml.Shema.XmISchema of available
MadCap element names.

m /Document OpenDocument(string) Opens the given file path and returns the associated IDocu-
ment. See "IDocument Interface" on the next page.

m /Document OpenDocument(string, EditorView) Opens the given file path in the EditorView
passed in and returns the associated IDocument. See "EditorView Enumeration” on page 19
and "IDocument Interface" on the next page.
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IDocument Interface

The IDocument interface provides access to components associated with an editor document.

PROPERTIES

m EditorView CurrentEditorView Gets the current EditorView in focus. See "EditorView Enu-
meration" on page 19.

m bool EnableLocks Gets and sets whether locks are enabled in the current document .

m /Selection Selection Gets the ISelection of the currently selected text. See "ISelection Inter-
face" on page 18.

m bool ShowChanges Gets and sets whether changes are shown in the current document.

m bool ShowlLocks Gets and sets whether locks are shown in the current document.

EVENTS

m Checkingln Occurs when the editor document checks in to source control.

m Closing Occurs when the editor document is closing.

m CurrentEditorViewChanged Occurs when the editor view switches focus.

m EnableLocksChanged Occurs when the editor document EnableLocks property changes.
m KeyDown Occurs when a key is pressed down while the editor document has focus.

m KeyUp Occurs when a key is released while the editor document has focus.

m MouseClick Occurs when the editor document is clicked by the mouse.

m MouseDoubleClick Occurs when the editor document is double-clicked by the mouse.
m MouseHover Occurs when the editor document is hovered over by the mouse.

m MouseMove Occurs when the mouse moves over the editor document.

= OnContentChanged Occurs when content is changed in the editor document.

m PreviewKeyDown Occurs before the KeyDown event when a key is pressed while the doc-
ument has focus.

m Printing Occurs when the Print or Print Preview command is invoked before the document
prints.

m Saved Occurs when the editor document saves.

m SavedAs Occurs when the editor document runs the "Save As' command..
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Saving Occurs before the editor document saves.

SavingsAs Occurs before the editor document runs the "Save As" command .

ShowChangesChanged Occurs when the editor document ShowChanges property changes.

ShowLocksChanged Occurs when the editor document ShowlLocks property changes.

METHODS

m bool ApplyStylesheet(string) Adds the referenced CSS stylesheet to the working list of styles.
Paths may be absolute or relative.

m void Close() Closes the document.
m void EndOperation() Ends the current operation.

m int GetCursorPosition() Returns the linear position of the insertion point. The intial position
starts from 0.

m string GetDocumentText() Returns the document text.
m string GetDocumentXml() Returns the xml of the document as text.
m string GetSourceUrl() Returns the url of the editor document.

m List<ToolStripltem> GetUserPendingContextMenultems() Returns the list of Sys-
tem.Windows.Forms.ToolStripltem(s) that are pending to be added to the context menu.

m XmIDocument GetXmIDocument() Returns the System.Xml.XmIDocument of the document.

= void InsertDocumentNode(XmINode, XmINode, int, bool) Inserts a new System.Xml.XmINode
as a child under the referenced parent node in the DOM. The last boolean parameter determ-
ines whether this operation will be reflected in the Flare Track Change system.

m void LookupVariableValue(string, string) Returns the value of the given variable set and name.

» void RemoveDocumentNode(XmINode, bool) Removes an existing System.Xml.XmINode
from the DOM. The last boolean parameter determines whether this operation will be reflec-
ted in the Flare Track Change system.

m bool RemoveStylesheet(string) Removes the referenced CSS stylesheet to the working list of
styles. Paths may be absolute or relative.

» void ReplaceDocumentNode(XmINode, XmINode, bool) Replaces an existing Sys-
tem.Xml.XmINode with a new node in the DOM. The last boolean parameter determines
whether this operation will be reflected in the Flare Track Change system.

m bool Save() Saves the current document. Returns bool indicating success of the operation.
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m void Select(string) Selects the first instance of text matching the search string after the cur-
rent position of the insertion point.

m void Select(XmINode) Selects the matching System.Xml.XmINode.

m void SetCursorPosition(int) Sets the position of the insertion point to the specified value.

m void StartOperation(string) Starts a new operation. All changes within a StartOperation and
EndOperation call will be bundled into one undoable operation in Flare's undo/redo stack.

» void UpdateView() Refreshes the document.

CHAPTER 2 17


http://msdn.microsoft.com/en-us/library/system.xml.xmlnode(v=vs.100).aspx

ISelection Interface

The ISelection interface provides functionality to edit the document selection.

PROPERTIES

bool IsBold Gets the value indicating whether the selection is bold.
bool Isltalic Gets the value indicating whether the selection is italic.
bool IsUnderlined Gets the value indicating whether the selection is underlined.

bool TrackChange Gets and sets the value indicating if ISelection operations are tracked.

METHODS

CHAPTER 2

bool Bold() Bolds the selection.

bool ChangeBackColor(Color) Changes the background of the selection to the specified Sys-
tem.Drawing.Color.

bool ChangeFontFamily(string) Changes the font family of the selection to the specified
value.

bool ChangeFontSize(float) Changes the font size of the selection to the specified value.

bool ChangeForeColor(Color) Changes the foreground color of the selection to the specified
System.Drawing.Color.

bool FormatStyle(string) Changes the span style of the selection to the specified CSS class
and/or ID.

Color GetBackColor() Returns the System.Drawing.Color of the background.

string GetFontFamily() Returns the font family of the selection.
floatGetFontSize() Returns the font size of the selection.

Color GetForeColor() Returns the System.Drawing.Color of the foreground.

string GetStyle() Returns the CSS class and/or ID of the selection.
string GetText() Returns the selected text.

IList<XmINode> GetXmINodeList() Returns a list of System.Xml.XmINode(s) that the selection
is a part of.

bool Italicize() Italicizes the selection.
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m bool RemoveFormatStyle(string) Removes the specified span style/class of the selection. If

the specified argument is null, all inline formatting is removed from the selection.

m bool ReplaceText(string) Replaces the selected text with the specified text.

» void SetSelectionLength(int) Sets the length of the selection to the specified value.

m bool Underline() Underlines the selection.
EditorView Enumeration
The EditorView enum defines constants, which indicate the type of editor views.

MEMBERS

m Text Text Editor view.

= Xml Xml Editor view.

CHAPTER 2
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INavContext Interface

Aninstance of INavContext is returned using the GetNavContext() method in the IHost interface
(see "IHost Interface" on page 13). INavContext gives access to the navigational user interface com-
ponents of Flare.

METHODS

m Form GetParentForm() Returns the parent System.Windows.Form. To be used as a reference
control for child windows.

m /CustomToolBar CreateCustomToolBar(string) Creates an instance of ICustomToolBar. See
"ICustomToolBar Interface" on the next page.

m /ToolStripMenultem CreateToolStripMenu(string, string) Creates an instance of
IToolStripMenultem to be added to the Tool Strip menu. See "IToolStripMenultem Interface”
on page 22.

m /Ribbon GetRibbon() Returns the current IRibbon object. See "IRibbon Interface" on page 23.
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ICustomToolBar Interface

The ICustomToolBar interface lets you build a custom toolbar to be added to the Tool Strip user
interface in Flare.

METHODS

m Button AddButton(string, ICommand, object, string, RibbonlconSize, string, string, string) Adds
a button to the toolbar. Returns an instance of System.Windows.Controls.Button.

m Button AddButton(IRibbonControlData) Adds a button to the toolbar. Returns an instance of
System.Windows.Controls.Button.

m /RibbonComboBox AddCombobox(string, ICommand, object, string, RibbonlconSize, string,
string, string) Adds a combo box to the toolbar. Returns an instance of IRibbonComboBox.
See "IRibbonComboBox Interface" on page 28.

» /RibbonComboBox AddCombobox(IRibbonMenuData) Adds a combo box to the toolbar.
Returns an instance of IRibbonComboBox. See "IRibbonComboBox Interface" on page 28.

m /RibbonMenu AddMenuButton(string, string, RibbonlconSize, string, string, string) Adds a
menu button to the toolbar. Returns an instance of IRibbonMenu. See "IRibbonMenu Inter-
face" on page 29.

» /RibbonMenu AddMenuButton(IRibbonMenuData) Adds a menu button to the toolbar. Returns
an instance of IRibbonMenu. See "IRibbonMenu Interface" on page 29.

m void AddSeparator() Adds a separator to the toolbar.

m /RibbonMenu AddSplitMenuButton(string, ICommand, object, string, RibbonlconSize, string,
string, string) Adds a split menu button to the toolbar. Returns an instance of IRibbonMenu.
See "IRibbonMenu Interface" on page 29.

» /RibbonMenu AddSplitMenuButton(IRibbonMenuData) Adds a split menu button to the tool-
bar. Returns an instance of IRibbonMenu. See "IRibbonMenu Interface" on page 29.

m ToggleButton AddToggleButton(string, ICommand, object, string, RibbonlconSize, string,
string, string) Adds a split menu button to the toolbar. Returns an instance of Sys-
tem.Windows.Controls.Primitives. ToggleButton.

m ToggleButton AddToggleButton(IRibbonControlData) Adds a split menu button to the toolbar.
Returns an instance of System.Windows.Controls.Primitives.ToggleButton.

NOTE: The custom toolbar is only visible when the Flare interface isin “Tool Strip” mode.
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IToolStripMenultem Interface

The IToolStripMenultem interface lets you build a custom Tool Strip menu to be added to Flare's
Tool Strip user interface.

METHODS

m /ToolStripMenultem AddMenultem(string, ICommand, object, string, RibbonlconSize, string,
string, string) Adds a menu item to the menu. Returns an instance of IToolStripMenultem.

m /ToolStripMenultem AddMenultem(IRibbonMenuData) Adds a menu item to the menu.
Returns an instance of IToolStripMenultem.

m void AddSeparator() Adds a separator to the menu.

CHAPTER 2

22



IRibbon Interface

The IRibbon interface provides the starting point to add custom elements to the application ribbon
user interface.

PROPERTIES

m bool IsCollapsed Gets the value indicating whether the ribbon is collapsed.

METHODS

m /RibbonTab AddNewRibbonTab(string, string) Adds a new tab to the ribbon. Returns an
instance of IRibbonTab. See "IRibbonTab Interface" on page 25.
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IRibbonControlData Interface

The IRibbonControlData interface gives users an object template for data binding to ribbon con-
trols.

PROPERTIES

m bool CanAddToQuickAccessToolBarDirectly Gets and sets a value that indicates whether this
control can be added directly to the Quick Access toolbar.

m /Command Command Gets and sets the command to execute.

m string Font Gets and sets the font.

m bool IsChecked Gets and sets a value that indicates whether this control is checked.
m string KeyTip Gets and sets the key tip value.

m string Label Gets and sets the label.

m string MenuLabel Gets and sets the menu label.

m /mageSource Largelmage Gets and sets the large image (32x32).

m bool ShouldExecuteCommand Gets and sets the value indicating whether the command
should be executed.

m /mageSource Smalllmage Gets and sets the smallimage (16x16).

m string ToolTipDescription Gets and sets the tool tip description.

m string ToolTipFooterDescription Gets and sets the tool tip footer description.
m Uri ToolTripFooterimage Gets and sets the tool tip footer image.

m string ToolTipFooterTitle Gets and sets the tool tip footer title.

m Uri ToolTiplmage Gets and sets the tool tip image.

m string ToolTipTitle Gets and sets the tool tip title.

m object Value Gets and sets the value.
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IRibbonMenuData Interface

The IRibbonMenuData interface gives you an object template for data binding to menu-type Ribbon
controls. It inherits from IRibbonControlData. See "IRibbonControlData Interface" on the previous

page.
PROPERTIES

m ObservableCollection<IRibbonControlData> ControlDataCollection Gets the collection of IRib-
bonControlData used to generate the content of the control. See "IRibbonControlData Inter-
face" on the previous page.

IRibbonTab Interface
The IRibbonTab interface represents a tab in IRibbon. See "IRibbon Interface" on page 23.

METHODS

m /RibbonGroup AddNewRibbonGroup(string) Adds a new ribbon group to the ribbon tab.
Returns an instance of IRibbonGroup. See "IRibbonGroup Interface” on the next page.
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IRibbonGroup Interface

The IRibbonGroup interface represents a group of controls that appear in IRibbonTab. See "IRib-
bonTab Interface” on the previous page.

METHODS

m Button AddRibbonButton(string, ICommand, object, string, RibbonlconSize, string, string,
string) Adds a ribbon button to the ribbon group. Returns an instance of Sys-
tem.Windows.Controls.Button.

m Button AddRibbonButton(IRibbonControlData) Adds a ribbon button to the ribbon group.
Returns an instance of System.Windows.Controls.Button.

m CheckBox AddRibbonCheckBox(string, ICommand, object, string, string, string) Adds a ribbon
check box to the ribbon group. Returns an instance of System.Windows.Controls.CheckBox.

m CheckBox AddRibbonCheckBox(IRibbonControlData) Adds a ribbon check box to the ribbon
group. Returns an instance of System.Windows.Controls.CheckBox.

m /RibbonComboBox AddRibbonCombobox(string, ICommand, object, string, RibbonliconSize,
string, string, string) Adds a ribbon combo box to the ribbon group. Returns an instance of IRib-
bonComboBox. See "IRibbonComboBox Interface" on page 28.

m /RibbonComboBox AddRibbonCombobox(IRibbonMenuData) Adds a ribbon combo box to the
ribbon group. Returns an instance of IRibbonComboBox. See "IRibbonComboBox Interface"
on page 28.

m /RibbonMenu AddRibbonMenuButton(string, string, RibbonlconSize, string, string, string) Adds
a ribbon menu button to the ribbon group. Returns an instance of IRibbonMenu. See "IRib-
bonMenu Interface" on page 29.

» /RibbonMenu AddRibbonMenuButton(IRibbonMenuData) Adds a ribbon menu button to the rib-
bon group. Returns an instance of IRibbonMenu. See "IRibbonMenu Interface" on page 29.

m /RibbonMenu AddRibbonSplitMenuButton(string, ICommand, object,string, RibbonlconSize,
string, string, string) Adds a ribbon split menu button to the ribbon group. Returns an instance
of IRibbonMenu. See "IRibbonMenu Interface" on page 29.

» /RibbonMenu AddRibbonSplitMenuButton(IRibbonMenuData) Adds a ribbon split menu button
to the ribbon group. Returns an instance of IRibbonMenu. See "IRibbonMenu Interface" on
page 29.
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m ToggleButton AddRibbonToggleButton(string, ICommand, object,string, RibbonlconSize,
string, string, string) Adds a ribbon split menu button to the ribbon group. Returns an instance
of System.Windows.Controls.Primitives. ToggleButton.

m ToggleButton AddRibbonToggleButton(IRibbonControlData) Adds a ribbon split menu button
to the ribbon group. Returns an instance of System.Windows.Controls.Primitives. Toggle But-

ton.

CHAPTER 2 27


http://msdn.microsoft.com/en-us/library/system.windows.controls.primitives.togglebutton.aspx
http://msdn.microsoft.com/en-us/library/system.windows.controls.primitives.togglebutton.aspx
http://msdn.microsoft.com/en-us/library/system.windows.controls.primitives.togglebutton.aspx
http://msdn.microsoft.com/en-us/library/system.windows.controls.primitives.togglebutton.aspx
http://msdn.microsoft.com/en-us/library/system.windows.controls.primitives.togglebutton.aspx

IRibbonComboBox Interface

The IRibbonComboBox represents a combo box on IRibbonTab. See "IRibbonTab Interface" on page
25.

METHODS

» void AddComboboxItem(string) Adds a combo box item with the specified value to the combo
box control.

m string GetComboboxValue() Gets the current value of the combo box control.

» void SetComboboxValue(string) Sets the current value of the combo box control to the spe-
cified string.
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IRibbonMenu Interface

The IRibbonMenu interface represents a menu on IRibbonTab. See "IRibbonTab Interface" on page
25.

METHODS

= void AddMenultem(string, ICommand, object, string) Adds a menu item for ribbon menu-type
controls.
m void AddSeparator() Adds a separator to the ribbon menu-type control.
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RibbonlconSize Enumeration

The RibbonlconSize enum defines constants, which indicate the size of a ribbon icon image.

MEMBERS

m Collapsed The image is not visible.
m Small The image size is 16x16 pixels at 96 DPI.
m Large Theimage size is 32x32 pixels at 96 DPI.
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When creating and working with the plug-in API, reviewing examples might be of use to you.

This chapter discusses the following:

Context Menu Example .. 32
Controlled Language Example ... ... 33
RIDbON EXample o 37
Search and Change Text Style Example ... ... ... 40
Toolbar EXample ... 41
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Context Menu Example

Following is an example of how to add and properly remove a context menu item for a given
instance of IDocument. See "IDocument Interface" on page 15.

% EXAMPLE
public void AddContextMenultem (IDocument doc)

{
1f (doc !'= null)

List<System.Windows.Forms.ToolStripItem> cms
doc.GetUserPendingContextMenultems () ;
cms.Add (new System.Windows.Forms.ToolStripMenultem

("Editor Plugin Item")):;

}

public void RemoveContextMenultem (IDocument doc)

{
1f (doc !'= null)

List<System.Windows.Forms.ToolStripItem> cms
mCurrentDocument.GetUserPendingContextMenultems () ;

cms.Clear ()

NOTE: If you have multiple documents with custom context menu items, you need to manu-
ally clear their context “toolstripitem” lists.
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Controlled Language Example

One of the most common uses for the Flare plug-in APl is to implement controlled language with
Simplified Technical English (STE). This lets you validate the language and terminology used in your
Flare content, ensuring the use of standardized vocabulary and style, while improving consistency,
eliminating ambiguity, and reducing complexity. This also means you can ensure compliance with
corporate terminology and style guide rules.

Two STE solutions that can be integrated with Flare come from Acrolinx (acrolinx.com) and Tedo-
pres (tedopres.com).
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% EXAMPLE

Let's say you use Tedopres HyperSTE, which is one of the leading software solutions
for STE. You want to integrate HyperSTE with your Flare project so that you can take
advantage of controlled language when you write topics and snippets. You might do
the following to set it all up and use it.

REGISTER HYPERSTE AND ENABLE THE PLUG-IN

1. Install HyperSTE and launch it.
a. Select HyperSTE for MadCap Flare.

&, Setup - HyperSTE

@’Etteplan [tedopres

Select Components

Which components should be installed?

Select the components you want to install; dear the components you do not want to
install. Click Next when vou are readv to continue.

] Plugins Application 0.2 MB
[] HyperSTE for MSWord
[7] Msward 2010 0.5M8
[] HyperSTE for Adobe FrameMaker
[ FrameMaker 9

[] HyperSTE for Adobe InDesign
[7] InDesign CSa

HyperSTE for MadCap Flare V9

Current selection requires at least 34.3 MB of disk space.

[ <gecc J ot QN Conce

b. Don't launch the license server.

c. Click Finish.
2. Open a Flare project and select File > Options. The Options dialog opens.
3. Select the Plugins tab.
4. Click Enable.
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w 5. Select the HyperSTE ribbon and click Check Document.

HyperSTE
ribbon

- e 5 able Help  HyperSTE
B E B L& 5 E ﬁ lﬁ E R B

Check Check Clear Report Look Export Add Edit Export Reload  Settings He Ip ASD-STE1I00 About ApplyStylesheet
Document Paragraph up Word Specification

Click Check
Document.

6. When you check a document for the first time, the HyperSTE plugin looks for
your associated license. If you don't have a license already, you'll need to
request one from Tedopres. To request a trial license of HyperSTE, contact
STE@tedopres.com.

7. When a license file is returned, save it on your machine.
8. From the HyperSTE ribbon, click Check Document.

9. Whenthe licensing Ul launches, select | have a license. This launches the
HyperSTE configuration wizard.

10. Click Next and set up HyperSTE, filling out the information as needed.
11. Browse for the V2C file and click Next.

12. Select a dictionary file (acquired from Tedopres).
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w USE HYPERSTE TO CHECK A CONTENT FILE IN FLARE
1. Open a projectin Flare.
Open the topic you want to validate.

From the HyperSTE ribbon, click Check Document.

> w0

Click on highlighted words throughout the topic. Notice the HyperSTE window
explaining the terms and usage.

I EE} Profile: Peneedural, CR: 12%
= % & e » |
|l Delete

Hon-Approved, verb, present tense

/B TopicLhtm x (&l StartPage x
1 + | Layout (Web) - Medium (default) = Page Layout - | [&] (& =] 5 + | 2

oy

[MadCap P il

5]
Hon-Appraved Forms:

Here is some general jtext 3 for a topi Origin: ASDSTET00

some general [jtext  fora [itopic . Replas
[stext  for a ptopic 3. Replace this with your own  [content gZHergis some general ftext q fora
topic 3. Replace this with your ;own 3 [rcontent 3. Here is soma general [vtext 3 for a [itopic 3]
Replace this with your [jown g [jcontent 9. Here is some/general [ylext ] fora opicy. Replace this

with your fown g [;content 3. Snippet:chapter beginning
Synonym Part of Speech  Origin

. z| s with your Euwn

[Fown 4] [eontent 3 Here is some general

Only use approved words listed in the
dictionary.

This word is non-approved. Use an appraved synonym
of rewrite your sentence.

{This chapter discusses the following. (This snippet is congitioned for print output) ErEEe verb ASD-STE100
Unk Word
Werds Frequency
= clicn 1

You can also use the other features shown in the HyperSTE ribbon in Flare.
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Ribbon Example

To add a ribbon tab for your plug-in, you need to use the INavContext interface. See "INavContext
Interface" on page 20.

From it, you may call GetRibbon() to retrieve an IRibbon instance. With the IRibbon instance, you
may add a new ribbon tab.

% EXAMPLE

Here is an example using data binding to the IRibbonControlData/IRibbonMenuData
interfaces. See "IRibbonControlData Interface" on page 24 and "IRibbonMenuData
Interface" on page 25.

private void CreatePluginRibbon ()

{
IRibbon ribbon = mNavigationContext.GetRibbon () ;
IRibbonTab tab ribbon.AddNewRibbonTab ("PluginTab™,
P
IRibbonGroup group = tab.AddNewRibbonGroup
("PluginGroup") ;
Button searchAndHighlightButton = group.AddRibbonButton
(PluginViewModel.SearchHighlight) ;
IRibbonComboBox comboMenu = group.AddRibbonCombobox
(PluginViewModel.Fonts) ;
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ﬁ Sam

ple code for the PluginViewModel:

public static classPluginViewModel
{
private staticRibbonControlData searchHighlight;
private staticRibbonMenuData fonts;
public staticRibbonControlData SearchHighlight
{
get
{
1f ( searchHighlight == null)
{
_searchHighlight = new RibbonControlData ()

{

Label = "Search and Highlight",
Command = new ButtonCommand(),
KeyTip = "S"

i
}
return _searchHighlight;
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{} public staticRibbonMenuData Fonts
{

BitmapImage image = new BitmapImage (new Uri
("C:/TFS/Trunk/ObjectApplications/Debug/Flare.app/
Plugins/NavigationPlugin/Icons/EditDocument.png"
))
_fonts = new RibbonMenuData ()
{
Label = "My Fonts",
LargeImage = image
i
_fonts.ControlDataCollection.Add (new
RibbonControlData ()
{
Label = "Arial"
b
_fonts.ControlDataCollection.Add (new
RibbonControlData ()
{
Label = "Helvetica"
b
_fonts.ControlDataCollection.Add (new
RibbonControlData ()
{
Label = "Times New Roman"
b);
}

return fonts;

NOTE: The ribbon tab is only visible when the Flare interface is in “Ribbon” mode.
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Search and Change Text Style Example

Following is a basic example where IEditorContext is used to search for a input string and change
the style of it throughout the document. See "IEditorContext Interface" on page 14.

% EXAMPLE

In this example, assume your class instance of IEditorContext is named “mEd-
itorContext.”

private void SearchAndChangeStyle(string searchString)
{

IDocument currentDocument = mEditorContext.GetActive
Document () ;
if (currentDocument != null)
{
string text = currentDocument.GetDocumentText () ;
int occurences = Regex.Matches (text,

searchString) .Count;

for (int i1 = 0; 1 < occurences; 1++)

{
currentDocument.Select (searchString) ;
currentDocument.Selection.ChangeBackColor
(Color.Yellow) ;
currentDocument.Selection.ChangeForeColor
(Color.Red);
currentDocument.Selection.ChangeFontFamily

("Comic Sans MS");
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Toolbar Example

To add a custom toolbar, you need to use the INavContext interface. See "INavContext Interface"

on page 20.

{

}

{

% EXAMPLE

Here is an example assuming your class instance of INavContext is named ‘mNav.”

private void CreateCustombar ()

ICustomToolBar toolBar = mNav.CreateCustomToolBar ("My
ToolBar") ;

toolBar.AddButton ("My Button",newButtonCommand()) ;
toolBar.AddSeparator () ;

toolBar.AddMenuButton (MyViewModel .MenuData) ;

ButtonCommand and MyViewModel are defined as follows:

public classButtonCommand :ICommand

public bool CanExecute (object parameter)

{

return true;

}

public voidExecute (object parameter)

{

MessageBox.Show ("I got pressed!");
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{} public static classRibbonViewModel
{
private static RibbonMenuData menuData;
public staticRibbonMenuData MenuData
{
get
{
1f ( _menubData ==null)
{
BitmapImage image =new BitmapImage (new Uri
("<ICON PATH>"));
_menuData =new RibbonMenuData ()
{
Label ="My Menu",
SmallImage = image,
KeyTip ="D"
i
~menuData.ControlDataCollection.Add (new
RibbonControlData ()
{
MenuLabel = "iteml"
b
~menuData.ControlDataCollection.Add (new
RibbonControlData ()
{
MenuLabel = "item2"
});
}

return menuData;

NOTE: The custom toolbar is only visible when the Flare interface isin “Tool Strip” mode.
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The following PDFs are available for download from the online Help.

TUTORIALS

Getting Started Tutorial
Product Foldout Tutorial
Side Navigation Tutorial

Top Navigation Tutorial

USER GUIDES

Accessibility Guide

Analysis and Reports Guide
Architecture Guide
Autonumbers Guide
Condition Tags Guide
Context-sensitive Help Guide
Eclipse Help Guide

Getting Started Guide

Global Project Linking Guide

APPENDIX

HTML Help Guide

HTML5 Guide

Images Guide

Importing Guide

Index Guide

Key Features Guide

Language Support Guide

MadCap Central Integration Guide

Master Pages Guide
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Micro Content Guide
Movies Guide

Navigation Links Guide
Plug-In API Guide
Print-based Output Guide
Project Creation Guide
Pulse Guide

QR Codes Guide

Reports Guide

Reviews & Contributions Guide
Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

CHEAT SHEETS

Folders and Files Cheat Sheet
Print Output Cheat Sheet
Shortcuts Cheat Sheet
Structure Bars Cheat Sheet

Styles Cheat Sheet

APPENDIX

Source Control Guide: Git

Source Control Guide: Perforce
Source Control Guide: Subversion
Source Control Guide: Team Foundation Server
Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Templates Guide

Topics Guide

Touring the Workspace Guide
Transition From FrameMaker Guide
Variables Guide

What's New Guide
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